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Documentation Updates 

This guide’s title page contains the following identifying information: 

• Software Version number, which indicates the software version. 

• Document Release Date, which changes each time the document is updated. 

• Software Release Date, which indicates the release date of this version of the software.


To check for recent updates, or to verify that you are using the most recent edition of a document, go to:


http://h20230.www2.hp.com/selfsolve/manuals 

This site requires that you register for an HP Passport and sign-in. To register for an HP Passport ID, go to: 

http://h20229.www2.hp.com/passport-registration.html 

Or click the New users - please register link on the HP Passport login page. 

You will also receive updated or new editions if you subscribe to the appropriate product support service. 
Contact your HP sales representative for details. 
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Support 

You can visit the HP Software Support Online web site at: 

http://www.hp.com/go/hpsoftwaresupport 

This web site provides contact information and details about the products, services, and support that HP 
Software offers. 

HP Software Support Online provides customer self-solve capabilities. It provides a fast and efficient way to 
access interactive technical support tools needed to manage your business. As a valued support customer, you 
can benefit by using the HP Software Support web site to: 

• Search for knowledge documents of interest


• Submit and track support cases and enhancement requests


• Download software patches


• Manage support contracts


• Look up HP support contacts


• Review information about available services


• Enter into discussions with other software customers


• Research and register for software training


Most of the support areas require that you register as an HP Passport user and sign in. Many also require a

support contract.


To find more information about access levels, go to:


http://h20230.www2.hp.com/new_access_levels.jsp 

To register for an HP Passport ID, go to: 

http://h20229.www2.hp.com/passport-registration.html 
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1 Overview 

This chapter covers the following topics: 

• Introduction to HP Performance Insight 

• Processing Traffic According to Priority 

• IP QoS Statistics Report Pack 

• Options for Customizing Reports 

• Sources for Additional Information 

HP Performance Insight 

Performance Insight is a performance management application that collects data from many 
sources, performs in-depth trend analysis, maintains performance baselines, and provides 
users with convenient, web-based reporting. Following is a partial list of product features: 

• Distributed architecture 

• Easy to scale (supports data collection from thousands of agents) 

• CODA/PA agent support 

• Multi-company security model 

• Data warehousing 

• Near Real Time reporting 

• Forecasting 

• Extensive aggregation (by day, week, month; by location, by customer) 

• Thresholding and alerting 

• Easy identification of bottlenecks 

• Easy assessment of capacity trends 

• Accurate and timely documentation for management 

• Integration with NNM 

• Integration with HP Operations/OM 

The reporting solutions created for Performance Insight cover many areas of business 
technology optimization. For a list of reporting solutions organized by technology, see 
Appendix B, PI Report Packs. 
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Processing Traffic According to Priority 

When a network that includes Cisco routers or Cisco Catalyst switches provides end-to-end 
Quality of Service (QoS), the routers and switches are able to distinguish higher-priority 
traffic from lower-priority traffic and process higher-priority traffic ahead of lower-priority 
traffic. End-to-end QoS offers the following benefits: 

• Bandwidth can be dedicated to particular types of traffic 

• Problems affecting real-time, interactive traffic (jitter and latency) can be controlled 

• Loss characteristics can be improved 

You can implement end-to-end QoS by using a router configuration interface to control the 
second byte in the header of the IP packet. The first three bits of the second byte indicate the 
level of precedence. There are eight precedence levels to choose from. The lowest level of 
precedence is 0 and the highest level of precedence is 7. 

Although QoS allows you to dedicate bandwidth to particular types of traffic, control jitter and 
latency, and improve loss characteristics, QoS will not tell you how much traffic of each service 
class is traversing the network, nor will it provide the hourly and daily information needed to 
design efficient QoS schemes. To find this data, you need to poll byte and packet counters in 
the IP Statistics MIB and process the data you collect. 

IP QoS Statistics Report Pack 

The IP QoS Statistics Report Pack polls the IP Statistics MIB, issues processing directives to 
PI, and displays reports that show the distribution of traffic on a per-precedence basis. The IP 
QoS Statistics Report Pack contains three reports: 

• Near Real Time Interface Activity 

• Historical Interface Activity 

• Inventory 

The Near Real Time report contains rate data for the previous 24 hours. Use this report to 
see byte and packet totals for each precedence level, in each direction, for every poll cycle 
during the previous six hours. 

The Historical Interface Activity report provides details about yesterday’s traffic volume 
per IP precedence level and displays hourly, daily, and monthly aggregations for any interface 
that has had traffic during the previous six hours. 

The Inventory report provides a list of all the ToS-enabled interfaces in your network. This 
report is refreshed after every poll cycle; the list of customers is updated once a day. 

The IP QoS Statistics Report Pack does not contain a thresholds sub-package. However, if you 
want to be notified when traffic of a particular IP-precedence is traversing the network, you 
can configure the Thresholds Module to generate the appropriate notification. Configuring the 
Thresholds Module involves modifying action and configuration files. This procedure is 
documented in the Thresholds Module User Guide. 
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The following table provides details about recent enhancements to IP QoS Statistics. 

Version Release Date Features/Enhancements 

1.00 May 2003 3 reports 
Sybase support 
Cisco IPQoSStat Datapipe 1.00 

2.00 October 2003 PI Object Manager support 

3.00 April 2004 PI 5.00 support 
Oracle support 
Cisco IPQoSStat Datapipe 2.00 

3.00 August 2004 UPGRADE_IP_QoS_Statistics_to_30.ap 

3.10 April 2007 Location Independent Reporting (LIR) 
SQL modified to support IR node/interface delete 
Cisco IPQoSStat Datapipe 3.10 
UPGRADE_IP_QoS_Statistics_to_31.ap 

3.20 October 2007 Prerequisites: 
• PI 5.30 
• Common Property Tables 3.70 
UPGRADE_IP_QoS_Statistics_to_32.ap 
• QXCR1000439333: IP_QoS_Statistics defect in 

create_IPQoSStat_ObjMan.sql 

3.30 February 2008 Copy Policy Enhancement 
UPGRADE_IP_QoS_Statistics_to_33.ap 

3.30 February 2009 Prerequisites: 
• PI 5.40 
• Common Property Tables 3.90 

The “to_33.ap” upgrade package is not available on CD-ROM. The “to_33.ap” upgrade 
package is available as a download only. The next chapter, the installation chapter, contains 
several references to a report pack CD-ROM. Ignore those references. If you need help 
downloading or installing this upgrade package, refer to release notes. 

Options for Customizing Reports 

You can change the contents of reports by applying group filters, by editing parameters, and 
by changing view options for tables and graphs. While service providers use group filters to 
produce customer-specific reports, any user can apply a constraint to a report or edit tables 
and graphs. For details about view options for tables and graphs, see Appendix A, Editing 
Tables and Graphs. 
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Adding customers and locations is another way to customize reports. However, unlike other 
reporting solutions you may be familiar with, there is no separate property import for IP QoS 
Statistics, and there are no property update forms. There is no separate property import 
because all of the property information associated with an interface (interface speed, 
customer, location, device name) is inherited from the Interface Reporting Report Pack. 

Group Filters 

If you want to share reports with your customers, you must configure PI to produce 
customer-specific reports. Here is an overview of the steps involved: 

• Use Common Property Tables to import customer names and device locations 

• Create a group account for all the users affiliated with each customer 

• Create a group filter for each group account


For more information about group filters, refer to the PI Administration Guide.


 Editing Parameters 

When you edit a parameter, you apply a constraint that eliminates the data you are not 
interested in seeing. If you edit the Customer Name parameter, data for all customers except 
the customer you typed in the Customer Name field drops from the report. If you edit the 
Source Location, data for all locations except the location you typed in the Source Location 
field drops from the report. 

You can apply multiple constraints at once. IP QoS Statistics supports these parameters: 

• Customer Name 

• Customer ID 

• Device Name 

• Interface Name 

• Admin Status 

If you are viewing the report on the web, edit parameters by clicking the edit parameters icon 
at the bottom right-hand corner of the report. When the Edit Parameters window opens, enter 
the constraint in the field and click Submit. 

If you are using Report Viewer, select Edit > Parameter Values from the menu bar. When the 
Modify Parameter Values window opens, click the Current Value field. Type a new value and 
click OK. 

Sources for Additional Information 

The demo package that comes with IP QoS Statistics contains a sample of each report in the 
package. If you have access to the demo package and you want to know what fully-populated 
reports look like, install the demo package. Demo reports are interactive and you can use 
them to experiment with parameters and view options. For information about recent 
enhancements to this package, refer to: 

• IP QoS Statistics Report Pack Release Notes 

• PI Report Packs, CD-ROM Release Notes, February 2009 
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For details about Interface Reporting and its datapipes, refer to: 

• Interface Reporting User Guide 

• Interface Reporting ifEntry Datapipe User Guide 

• Interface Discovery Datapipe User Guide 

Manuals for the core product and manuals for the reporting solutions that run on 
Performance Insight can be downloaded from this site: 

http://h20230.www2.hp.com/selfsolve/manuals 

The user guides for PI are listed under Performance Insight. The user guides for report packs 
and datapipes are listed under Performance Insight Report Packs. You will see a date next to 
each manual. If a manual is revised and reposted, the date will change. Since we post revised 
manuals on a regular basis, you should check this site for updates. 
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2 Package Installation 

This chapter covers the following topics: 

• Guidelines for a Smooth Install 

• Upgrading to Version 3.30 

• Installing IP QoS Statistics 3.30 for the First Time 

• Accessing Deployed Reports 

• Setting Up a Distributed System 

• Package Removal 

Guidelines for a Smooth Install 

The report pack CD has the latest report packs and datapipes. When you insert the CD in the 
CD-ROM drive and launch the package extraction program, the install script on the CD 
extracts every package from the CD and copies the results to the Packages directory on your 
system. When the extract finishes, the install script prompts you to launch PI and start 
Package Manager. Before using Package Manager, review the following guidelines. 

Prerequisites for Installation 

IP QoS Statistics has a combination of core-product requirements and package level 
requirements. The core-product requirements are: 

• Performance Insight 5.40 

• All Service Packs available for the version of PI 5.40


The package-level prerequisites are:


• Common Property Tables 3.90 

• Interface Reporting Report Pack 5.50 

Upgrading Common Property Tables 

If you are running an earlier version of Common Property Tables, version 3.70 or earlier, 
upgrade to the latest version by installing the upgrade package. Installing this upgrade 
package is no different from installing other upgrade packages; however, you cannot install 
other packages when you install the upgrade package for Common Property Tables. Install 
the upgrade package for Common Property Tables and only the upgrade package for Common 
Property Tables. 
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Distributed Environments 

If you are running IP QoS Statistic as a distributed system across multiple servers, the 
central server, every satellite server, and every remote poller must be running the same 
version of PI and all available service packs for that version of PI. When you install IP QoS 
Statistics on the central server, deploy reports. When you are done installing packages, you 
must configure each server by following the steps under Setting Up a Distributed System on 
page 21. 

Polling Policies for Remote Pollers 

When you uninstall an existing datapipe, the following information will be lost: 

• The polling policy for a single remote poller 

• Cloned polling policies for multiple remote pollers 

• Customized polling groups 

You can export existing polling policy configurations and customized polling groups by using 
the collection_manager and group_manager commands. 

Exporting Polling Policy Configurations 

If your environment contains polling policies for remote pollers, use the collection_manager 
command to export existing policy configurations to a file. 

UNIX: As user trendadm, run the following command: 

cd $DPIPE_HOME 

./bin/collection_manager -export -file /tmp/savePollingPolicy.lst 

Windows: As Administrator, launch a command window. Navigate to the PI install directory 
and run the following command: 

bin\collection_manager -export -file \temp\savePollingPolicy.lst 

Exporting Polling Group Configurations 

If your environment contains customized polling groups, use the group_manager command to 
export groups to individual .xml files. 

UNIX: As user trendadm, run the following command: 

cd $DPIPE_HOME 

./bin/group_manager -export_all -outfile /tmp/savePollingGroups 

Windows: As Administrator, launch a command window, then navigate to the PI install 
directory and run the following command: 

bin\group_manager -export_all -outfile \temp\savePollingGroups 

Deleting Custom Views of Data or Property Tables 

If you created custom views for data or property tables, the view you created may interfere 
with the report pack upgrade, causing the upgrade to fail. Whether or not your views interfere 
with the upgrade process depends on how you created them. If you created them using SQL, 
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the upgrade will succeed but your views will not be available once the upgrade is complete. If 
you created them using Datapipe Manager, the upgrade is likely to fail. To prevent the 
upgrade from failing, be sure to delete your views prior to upgrading the report pack. Once the 
report pack has been upgraded, you can use Datapipe Manager to recreate custom views. 

Upgrading to Version 3.30 

Perform the following tasks to upgrade to version 3.30: 

•	 Task 1: Stop OVPI Timer and extract packages from the report pack CD 

•	 Task 2: Upgrade to Common Property Tables 3.90 

•	 Task 3: Upgrade to Interface Reporting 5.50 

•	 Task 4: Install IP_QoS_Statistics_Upgrade_to_33 

•	 Task 5: Remove Cisco IPQoSStat Datapipe 3.00 

•	 Task 6: Install Cisco IPQoSStat Datapipe 3.10 

•	 Task 7: Restart OVPI Timer 

Task 1: Stop OVPI Timer and extract packages from the report pack CD 

1	 Log in to the system. On UNIX systems, log in as root. 

2	 Stop OVPI Timer and wait for processes to terminate.


On Windows, do the following:


a	 Select Control Panel > Administrative Tools > Services. 

b Select OVPI Timer from the list of services.


c From the Action menu, select Stop.


On UNIX, as root, do one of the following:


HP-UX: sh /sbin/init.d/ovpi_timer stop 

Sun: sh /etc/init.d/ovpi_timer stop 

3 Insert the report pack CD in the CD-ROM drive. On Windows, a Main Menu opens 
automatically; on UNIX, mount the CD if the CD does not mount automatically, navigate 
to the top level directory on the CD, and run the ./setup command. 

4 Type 1 in the choice field and press Enter. The install script displays a percentage complete 
bar. When the copy is complete, the install script starts Package Manager. The Package 
Manager welcome window opens. 

If you navigate to the Packages directory on your system, you will see the following folders 
under the IP_QoS_Statistics folder: 

•	 Docs 

•	 IP_QoS_Statistics.ap 

•	 IP_QoS_Statistics_Demo.ap 

•	 UPGRADE_IP_QoS_Statistics_to_33.ap 
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Task 2: Upgrade to Common Property Tables 3.90 

Follow these rules: 

•	 Do not install any other package with the Common Property Tables upgrade package; 
install the Common Property Tables upgrade package and only the Common Property 
Tables upgrade package. 

•	 When prompted to accept or disable the option to Deploy Reports, accept the default. If 
you do not deploy reports, you will not deploy the change forms that come with Common 
Property Tables. 

• When the install finishes, click Done to return to the Management Console. 

If you need more help with this task, refer to the Common Property Tables User Guide. 

Task 3: Upgrade to Interface Reporting 5.50 

1	 If you have not already upgraded to IR 5.50, install Interface_Reporting_Upgrade_to_55. 

2	 Upgrade the Interface Reporting datapipes. If necessary, see the Interface Reporting 
Report Pack User Guide for more information about the upgrade procedure. 

3	 Once the install of the new datapipes is complete, click Done to return to the Management 
Console. 

Task 4: Install IP_QoS_Statistics_Upgrade_to_33 

1 Start Package Manager. The Package Manager welcome window opens. 

2 Click Next. The Package Location window opens. 

3	 Click Install. 

4	 Click Next. The Report Deployment window opens. Accept the defaults for Deploy Reports, 
Application Server, and Port. Type your user name and password for the PI Application 
Server. 

5 Click Next. The Package Selection window opens. 

6 Click the check box next to the following package: IP_QoS_Statistics_Upgrade_to_33 

7 Click Next. The Type Discovery window opens. Disable the default. 

8 Click Next. The Selection Summary window opens 

9	 Click Install. The Installation Progress window opens and the install begins. When the 
install finishes, a package install complete message appears. 

10	 Click Done. 

Task 5: Remove Cisco IPQoSStat Datapipe 3.00 

The Cisco IPQoSStat Datapipe cannot be upgraded. You must remove Cisco IPQoSStat 
Datapipe 3.00. Start Package Manager and follow the on-screen instructions for package 
removal. When Package Manager tells you that removal is complete, click Done to return to 
the Management Console. 

Task 6: Install Cisco IPQoSStat Datapipe 3.10 

1 Start Package Manager. The Package Manager welcome window opens. 

2 Click Next. The Package Location window opens. 

3 Click Install. 
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4 Click Next. The Report Deployment window opens; disable the default for Deploy Reports. 

5 Click Next. The Package Selection window opens. 

6 Click the check box next to the following package: 

Cisco IPQoSStat Datapipe 3.1 

7 Click Next. The Type Discovery window opens. 

8 Click Next. The Selection Summary window opens. 

9 Click Install. The Installation Progress window opens and the install begins. When the 
install finishes, the package installation complete message appears. 

10 Click Done. 

Task 7: Restart OVPI Timer 

On Windows, do the following: 

1 Select Control Panel > Administrative Tools > Services. 

2 Select OVPI Timer from the list of services.


3 From the Action menu, select Start.


On UNIX, as root, do one of the following:


HP-UX: sh /sbin/init.d/ovpi_timer start 

Sun: sh /etc/init.d/ovpi_timer start 

Installing IP QoS Statistics 3.30 for the First Time 

Follow these steps to install theIP QoS Statistics Report Pack: 

• Task 1: Stop OVPI Timer and extract packages from the report pack CD 

• Task 2: If necessary, upgrade to Common Property Tables 3.70 

• Task 3: Install the following packages: 

• IP_QoS_Statistics 3.30 

• Cisco_IPQoSStat_Datapipe 3.10 

Task 1: Extract packages from the report pack CD 

1 Log in to the system. On UNIX systems, log in as root.


2 Stop OVPI Timer and wait for processes to terminate.


Windows: Select Control Panel > Administrative Tools > Services 

UNIX: As root, do one of the following:


HP-UX: sh /sbin/init.d/ovpi_timer stop


Sun: sh /etc/init.d/ovpi_timer stop


3 Insert the report pack CD in the CD-ROM drive. On Windows, a Main Menu displays 
automatically. On UNIX, the CD may or may not mount automatically; if it does not 
mount automatically, navigate to the top level directory on the CD, and run the ./setup 
command. 
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4 Type 1 in the choice field and press Enter. The install script displays a percentage complete 
bar. When the copy is complete, the install script starts Package Manager. The Package 
Manager install wizard opens. 

You have the option of navigating to the Packages directory to see the results. The Packages 
directory contains separate folders for IP QoS Statistics and the Cisco IPQoSStat Datapipe. 
The following folders appear under the IP QoS Statistic folder: 

• IP_QoS_Statistics.ap 

• IP_QoS_Statistics_Demo.ap 

• UPGRADE_IP_QoS_Statistics_to_3.3.ap 

You can ignore the upgrade package The following folder appears under 
Cisco_IPQoSStat_Datapipe: 

• Cisco_IPQoSStat_Datapipe.ap 

Installing the demo package is optional. You may install the demo package by itself, with no 
other packages, or you may install the demo package along with other packages. 

Task 2: Upgrade to Common Property Tables 

IP QoS Statistics requires Common Property Tables. If you have not already upgraded to 
Common Property Tables 3.90, do this now. If you need help with the upgrade, refer to the 
Common Property Tables User Guide. When the install finishes, click Done to return to the 
Management Console. 

Task 3: Install IP QoS Statistics and the IP QoSStat Datapipe 

1 Log in to the system. On UNIX systems log in as root.


2 Start Package Manager. The Package Manager welcome window opens.


3 Click Next. The Package Location window opens.


4 Click Install. Approve the default installation directory or select a different directory, if 

necessary. 

5 Click Next. The Report Deployment window opens. Accept the default for Deploy Reports; 
accept the defaults for application server name and port; and type your user name and 
password for the PI Application Server. 

6 Click Next. The Package Selection window opens. 

7 Click the check box next to the following packages: 

IP_QoS_Statistics


IP_QoS_Statistics_Demo


Cisco_IPQoSStat_Datapipe


8 Click Next. The Type Discovery window opens. Keep the default and click Next. The 
Selection Summary window opens. 

9 Click Install. The Install Progress window opens. When installation finishes, an install 
complete message appears. 

10 Click Done to return to the Management Console. 
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Accessing Deployed Reports 

When you installed IP QoS Statistics, you enabled the Deploy Reports option. As a result, the 
reports in this package (as well as any forms associated with the package) were deployed to 
the PI Application Server. Once reports reside on the PI Application Server, you have two 
ways to view them: 

• PI client applications 

• Web browser 

If the client applications are installed on the user’s system, the user has access to Report 
Viewer, Report Builder, and the Management Console. If the client applications are not 
installed on the user’s system, using a web browser to view reports is the only way the user 
can view reports. 

For more information about the clients, refer to the PI Installation Guide. For details about 
the Management Console, including how to use the Object/Property Management view to 
launch reports specific to a selected object, refer to the PI Administration Guide. 

Setting Up a Distributed System 

Before Location Independent Reporting (LIR) was available, our recommendation to anyone 
setting up a distributed system was to deploy reports on satellite servers, keep rate data on 
satellite servers, copy hourly data to the central server, and disable summarizations above the 
hourly level on satellite servers. This approach had two benefits. It kept a lot of rate data off 
the network, and it decreased the processing load on the central server. The problem with this 
approach is that the central server could not display a Near Real Time (NRT) report. The only 
NRT report was a local NRT report, on a satellite server. 

LIR fixes this problem. If you enable LIR, you can open an NRT report on the central server 
and drill-down on table selections. The selections you make cause the central server to query a 
satellite server for locally aggregated data. Of course, if you would rather copy rate data to the 
central server, you can. If you do, then enabling LIR is not necessary. 

The IP QoS Report Pack comes with a copy policy import file. When you install the report 
pact, PI uses this file to generate copy policies. Creating these policies yourself, using the 
Management Console, is no longer necessary. Your only task is to verify that you have the 
copy policies you need. 

Because you are likely to have multiple satellite servers, we designed the hourly process files 
to be satellite-server friendly. This means that most of the time, most of the defaults are 
correct. But some defaults will be incorrect, or less than optimal, and to improve performance, 
you should change them. These manual edits, as well as the other steps listed above, are 
spelled out below. 

Configuring the Central Server 

To configure the central server, perform the following tasks: 

• Task 1: Register the satellite server by setting the database role 

• Task 2: If you are not copying rate data from satellites to the centrals server, enable LIR 

• Task 3: If you enable LIR, add LIR mappings 
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• Task 4: Verify the automatically generated copy policies 

• Task 5: Modify the trendtimer.sched file 

Task 1:	 Register the satellite server by setting the database role 

1 Start the Management Console (log on with Administrator privileges). 

2 Click the Systems icon in the navigation pane. 

3 Navigate to the OVPI Databases folder and select the database system. 

4 Click Database Properties. 

5 From the Database Role list, select the Satellite Server role. 

6 Enter any information necessary to configure the Satellite Server role. 

To add a new database reference, you can use the Add Database Reference Wizard in the 
System and Network Administration application. 

Task 2:	 If you are not copying rate data from the satellites to the central server, enable LIR 

1 Start the Management Console (log on with Administrator privileges). 

2 Click the Systems icon in the navigation pane. 

3 Navigate to the OVPI Databases folder and select the central server. 

4 Click LIR Configuration. 

5 Select the LIR enabled check box. 

Task 3: If you enable LIR, add LIR mappings 

1 Start the Management Console (log on with Administrator privileges). 

2 Click the Systems icon in the navigation pane. 

3 Navigate to the OVPI Databases folder and select the central server. 

4 Click LIR Configuration. 

5 Click Add Mapping. 

6 From the Select Satellite Server list, select a satellite server to which to add a mapping. 

7 Select the Category data table option. 

8 Select IP QoS Statistics from the drop down list. 

9 Select the rate data type. 

10 Click Add to List. 

11 If you want to add additional LIR mappings, click Add Mapping and repeat step 6 through 
step 10. 

12 Click OK. 

13 Click Apply. 

A copy policy is automatically generated for the hourly data and for each LIR mapping that 
you add. The data type selected when adding an LIR mapping (in step 9 above) determines 
the type of data copied (defined in the generated copy policy). The type of data copied (defined 
in the generated copy policy) is one summarization level greater than the data type selected in 
the LIR mapping. For example, if you select an hourly data type, you will generate a daily 
data copy policy. 
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Task 4: Verify the automatically generated copy policies 

Verify that a copy policy has been generated for the following tables and that the copy type is 
set correctly (to Property and Data): 

1 Start the Management Console (log on with Administrator privileges). 

2 Click the Copy Policy icon in the navigation pane to start the Copy Policy Manager. 

3 Find the following tables and verify the copy type is set to Property and Data for each table: 

• RIPStatData 

• SHIPStatData 

• SHIPStatInterfaceData 

If a copy policy has not been generated for a table, do the following: 

1 Click the New Copy Policy icon or select File > New Copy Policy from the Copy Policy 
Manager. The Copy Policy Wizard displays. 

2 Click Next. The Satellite Server and Copy Policy Selection Page displays. 

3 Select a satellite server from the pull down list. This is the satellite server from which 
data is copied to the central server. 

4 Select Single Table and select the table from the pull down list. 

5 Click Next. The Copy Type Selection Page displays. 

6 Select Property and Data. 

7 Click Next. The Summary page displays. 

8 Verify the information in the summary window. If the information is not correct, you can 
modify it by clicking Back.


9 Click Finish.


10 Repeat step 4 - step 9 for all missing tables.


If the copy type is not set to Property and Data, do the following:


1 Double-click the copy policy.


2 Select the Property and Data copy type.


3 Click OK.


Task 5: Modify the trendtimer.sched file 

The trendtimer.sched file is found in the {DPIPE_HOME}/lib/ directory where 
{DPIPE_HOME} is the directory in which PI is installed. 

Make the following change to this file: 

• Find and comment out the following line: 

1:00+30 - - {DPIPE_HOME}/bin/trend_proc -f

{DPIPE_HOME}/scripts/IPStat_Hourly_Process.pro
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Configuring Satellite Servers 

Follow these steps to configure each satellite server. 

1 Modify the {DPIPE_HOME}/lib/trendtimer.sched file (where {DPIPE_HOME} is the 
directory in which PI is installed). Do the following: 

•	 Find and comment out the following line (to switch off interface aggregations above 
the hourly level): 

24:00+3:00 - - {DPIPE_HOME}/bin/trend_proc -f
{DPIPE_HOME}/scripts/IPStat_DMF_Process.pro 

If you want the server to perform a local reporting function, do not switch off the 
higher aggregations. Switching off the higher aggregations disables everything 
except the NRT reports. 

•	 Modify the IPStat_Hourly_Process.pro trendtimer entry in the {DPIPE_HOME}/lib/
trendtimer.sched file. By default, this process starts at 30 minutes after the hour. 
To make sure the satellite server completes hourly summarizations before the central 
server begins hourly summarizations, change the start time from 1:00+30 to 1:00+15 

2	 Modify the IPStat_Hourly_Process.pro file (found in the {DPIPE_HOME}/scripts/ 
directory where {DPIPE_HOME} is the directory in which PI is installed): 

Uncomment the IPStat_2 block (uncomment the begin:IPStat_2 wait and 
end:IPStat_2 lines). 

3	 Configure polling policies for the Cisco IPQoSStat Datapipe, making sure that each 
Interface is polled by one satellite server only. 

System Clocks 

Make sure that the system clock on each satellite server is synchronized with the system clock 
on the central server. 

Package Removal 

Follow the steps below to uninstall the IP QoS Statistics. Removing the report pack

automatically removes the datapipe.


1 Log in to the system. On UNIX systems, log in as root.


2 Stop OVPI Timer and wait for processes to terminate.


Windows: Select Control Panel >  Administrative Tools > Services 

UNIX: As root, do one of the following:


HP-UX: sh /sbin/init.d/ovpi_timer stop


Sun: sh /etc/init.d/ovpi_timer stop


3 Start Package Manager. The Package Manager welcome window opens. 

4 Click Next. The Package Location window opens. 

5	 Click Uninstall. Keep the defaults. 

6 Click Next. The Package Selection window opens. 
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7 Click the check box next to the following packages: 

IP_QoS_Statistics


IP_QoS_Statistics_Demo


8 Click Next. The Selection Summary window opens. 

9 Click Uninstall. The Progress window opens. When the removal finishes, a removal complete 
message appears. 

10 Click Done to return to the Management Console. 

11 Restart OVPI Timer. 

Windows: Select Control Panel > Administrative Tools > Services 

UNIX: As root, do one of the following:


HP-UX: sh /sbin/init.d/ovpi_timer start


Sun: sh /etc/init.d/ovpi_timer start

Package Installation 25 



26 Chapter 2 



3 Reports from the Demo Package

Inventory Report 

The Inventory report provides a list of all the interfaces in the network enabled for IP QoS 
Statistics and provides basic provisioning information for each interface. Use this report to 
keep track of interfaces on a customer-by-customer basis and to compare interfaces on 
different devices. Interface details are updated after every poll cycle, while the list of 
customers is refreshed once a day. The data in this report is inherited from the Interface 
Reporting Report Pack. 

Near Real Time Interface Activity 

Near Real Time Interface Activity contains recent sample data as opposed to hourly or daily 
averages. All of the interfaces appearing in the pick-list at the top of the report had at least 
some IP QoS accounting traffic during the previous six hours. This report populates with data 
before the other two reports populate with data. Data will begin to appear in this report after 
three polling cycles. 

When you select an interface from the list, the two hourly graphs and the table below refresh 
to show traffic volume on a per-precedence basis over the previous 24 hours. The input and 
output graphs show traffic volume for each precedence level. The table below shows volume 
data for each precedence level on a per-poll basis. In this example, polling is taking place 
every 15 minutes. 

Historical Interface Activity 

Historical Interface Activity is similar to the NRT report. However, the graphs show data at 
the daily level, while the table below lets you choose among three time periods—hourly, daily, 
and monthly. Like the NRT report, Historical Interface Activity provides an easy way to find 
out when each class of traffic is traversing the network. Unlike the NRT report, Historical 
Interface Activity reveals trends, week to week, and month to month. In the selection table 
you have a list of every interface that had at least some traffic during the previous six hours. 
For each interface, you also have device, customer, ifSpeed, and location details. 

The color-coded bar charts, one for each direction, track daily ups and down in traffic volume, 
and show the distribution of traffic by precedence level. The data tables provide hourly, daily, 
and monthly views of traffic volume by precedence level in each direction. The hourly tab 
shows data for the previous day; the daily tab shows data for the previous 90 days; the 
monthly tab shows data for the last few months. 
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A Editing Tables and Graphs

Any table or graph can be viewed in several ways. While the default view is usually adequate, 
you can easily change to a different view. If you are using Report Viewer, right-click the object 
to display a list of view options. If you are using the Web Access Server, follow these steps to 
change the default view of a table or graph: 

1 Click Preferences on the links bar. 

2 Expand Reports in the navigation frame. 

3 Click Viewing. 

4 Select the Allow element editing box. 

5 Click Apply. 

6 Click  (the Edit icon) next to the table or graph. 

View Options for Tables 

Right-clicking a table, or selecting the Edit Table icon if you are using the Web Access Server, 
opens a list of table view options. 

Select Set Time Period to alter the relative time period (relative to now) or set an absolute time 
period. The Set Time Period window opens. 

You may shorten the period of time covered by the table from, for example, 42 days to 30 days 
or to 7 days. If you are interested in a specific period of time that starts in the past and stops 
before yesterday, click Use Absolute Time and select a Start Time and an End Time. 

Select Change Constraint Values to loosen or tighten a constraint, thereby raising or lowering the 
number of elements that conform to the constraint. The Change Constraint Values window 
opens. To loosen a constraint, set the value lower; to tighten a constraint, set the value higher. 

The Select Nodes/Interfaces allows you to change the scope of the table by limiting the table to 
specific nodes, specific interfaces, or a specific group of nodes or interfaces. The Select Node 
Selection Type window opens. 
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Change Max Rows increases or decreases the number of rows in a table. The default is 50. If you 
expand the default, the table may take more time to open. If you are trending a large network, 
using the default ensures that the table opens as quickly as possible. 
View in new Frame opens the table in a Table Viewer window, shown below. If necessary, make 
the data in the table more legible by resizing the window. 

View Options for Graphs 

Right-clicking a graph, or clicking the Edit Graph icon if you are using the Web Access Server, 
opens the following list of view options. 
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The following table provides details about each option. 

Option 

Set Time Period 

Change Constraint Values 

Select Nodes/Interfaces 

Displayed Data 

Grid 

Legend 

Style 

Change Max Rows... 

Display Data Table 

Export Element as CSV... 

View in New Frame 

Print Graph 

Function 

Same as the table option shown above. 

Same as the table option shown above. 

Same as the table option shown above. 

For every point on a graph, display data in a 
spreadsheet. 

Add these to the graph: 
X axis grid lines 
Y axis grid lines 
X and Y axis grid lines 

Delete or reposition the legend. 

See the illustrations below. 

Same as the table option shown above. 

See below. 

Same as the table option shown above. 

Opens graph in a Graph Viewer window. 

Same as the table option shown above. 

Style Options 

Select Style to display a list of seven view options for graphs. 
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Style > Area 

The plot or bar chart changes to an area graph. While relative values and total values are 
easy to view in this format, absolute values for smaller data types may be hard to see. Click 
anywhere within a band of color to display the exact value for that location 

To shorten the time span of a graph, press SHIFT+ALT and use the left mouse button to 
highlight the time span you want to focus on. Release the mouse button to display the selected 
time span. 

Style > Stacking Area 

The area or plot graph changes to a stacking area graph. This view is suitable for displaying a 
small number of variables. 
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Style > Bar 

The graph changes to a bar chart. This view is suitable for displaying relatively equal values 
for a small number of variables. There are three variables in the graph below. 

Style > Stacking Bar 

The plot or area graph changes to a stacking bar chart. If you increase the width of the frame, 
the time scale becomes hourly. If you increase the height of the frame, the call volume shows 
in units of ten. 
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Style > Plot 

Bands of color in an area graph change to lines. If you adjust the frame width, you can make 
the data points align with hour; if you adjust the frame height, you can turn call volume into 
whole numbers. 

Style > Pie 

An area graph becomes a pie chart. Bands in an area graph convert to slices of a pie and the 
pie constitutes a 24-hour period. This view is helpful when a small number of data values are 
represented and you are looking at data for one day. 

If you are looking at data for more than one day, you will see one pie graph for each day. 
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Display Data Table 

This option changes a graph into a spreadsheet. 

View in New Frame 

The graph opens in a Graph Viewer window. Improve legibility by resizing the window. 
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B PI Report Packs 

Business Technology 

Application 

Database 

HP Business Process Insight 

HP Internet Services 

HP Network Node Manager 

HP Operations 

HP Service Desk 

IP Telephony 

MPLS VPN 

Networking 

Reporting Solution 

Application Report Pack: 
• WebLogic SPI 
• WebSphere SPI 

Database SPI Report Pack 

BPI Report Pack 

Internet Services Report Pack 

NNM Event & Availability Report Pack 

OVO Report Pack 

Help Desk Report Pack 
Change Management Report Pack 
SLM Integration Report Pack 

• Cisco IP Telephony Call Detail 
• Cisco IP Telephony Gateway Statistics 

MPLS VPN Report Pack 

Infrastructure Usage 

• Interface Reporting 
• Device Resource Report Pack 

LAN/WAN Edge 

• Frame Relay (SNMP only) 
• ATM (SNMP only) 

WAN Core 

• Frame Relay (multiple switch vendors) 
• ATM (multiple switch vendors) 
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Business Technology 

Networking (continued) 

System Resources 

Reporting Solution 

Traffic Profiling 

• RMON II 

• NetFlow Interface 

• NetFlow Global View 

• IP QoS Report Pack 

• Class-Based QoS 

Quality Assurance 

• Cisco Ping Report Pack 
• Service Assurance 
• IP Access Rate 

• System Resource Report Pack 
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We appreciate your feedback! 

If an email client is configured on this system, by default an email window opens when you 
click on the bookmark “Comments”. 

In case you do not have the email client configured, copy the information below to a web mail 
client, and send this email to docfeedback@hp.com 

Product name:


Document title:


Version number:


Feedback:
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